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1 Introduction
IBM® Rational® Change is a generic change request management system that is 
Web-based and integrated with IBM® Rational® Synergy. This chapter provides 
basic information needed to install Rational Change:

• “Readme” on page 1

• “Conventions” on page 2

• “Contacting IBM Rational Software Support” on page 3

To make your installation easier, a “Worksheet” on page 27 is included in this 
document. Print a copy of the worksheet, and fill in as much information as 
possible before installing the product.

Readme
The Readme contains vital information about your Rational Change software, 
including information about new features in this release, and a list of the 
supported hardware and operating systems. Review this information before 
installing your software. The Readme is available on the Rational Software 
Information Center Web site and on the Documentation section of the DVD that 
was shipped with Rational Change.
When necessary, the Readme is revised and reissued to provide the most current 
information. To ensure you have the latest version, download an electronic copy 
from the Rational Software Information Center at http://
publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/index.jsp.

Changes in version 5.2
Telelogic Change is now called IBM Rational Change. Also, if you are upgrading 
from Telelogic Change 5.1, the feature called Telelogic Change Distributed is now 
referred to as Rational Change Distributed and is included in the Rational Change 
product.
IBM Rational Change Installation Guide 1
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Chapter 1: Introduction
Conventions
The following describes the conventions used in this document.

Typefaces and symbols

The table below describes the typeface and symbol conventions used in this 
guide.

This document also uses the following conventions:

Note  Contains information that should not be overlooked. 

Caution  Contains critical information that must be observed or 
damage to the database or system could result.

Typeface Description

Italic Used for book titles and terminology. Also designates names 
of roles (User), states (working), and users (sue).

Bold Used for items that you can select and menu paths, also used 
for emphasis.

Courier Used for commands, filenames, and directory paths. 
Represents command syntax to be entered verbatim. Signifies 
computer output that displays on-screen. Also used for the 
names of attributes (modify_time), functions 
(remote_type), and types (csrc).

Courier Italic Represents values in a command string that you supply. For 
example, (drive:\username\commands).
2 IBM Rational Change Installation Guide



Contacting IBM Rational Software Support
Contacting IBM Rational Software Support
If the self-help resources have not provided a resolution to your problem, you 
can contact IBM® Rational® Software Support for assistance in resolving 
product issues.

Note  If you are a heritage Telelogic customer, a single reference 
site for all support resources is located at http://
www.ibm.com/software/rational/support/telelogic/

Prerequisites
To submit your problem to IBM Rational Software Support, you must have an 
active Passport Advantage® software maintenance agreement. Passport 
Advantage is the IBM comprehensive software licensing and software 
maintenance (product upgrades and technical support) offering. You can enroll 
online in Passport Advantage from at http://www.ibm.com/software/lotus/
passportadvantage/howtoenroll.html.

• To learn more about Passport Advantage, visit the Passport Advantage 
FAQs at http://www.ibm.com/software/lotus/passportadvantage/
brochures_faqs_quickguides.html.

• For further assistance, contact your IBM representative.

To submit your problem online (from the IBM Web site) to IBM Rational 
Software Support, you must additionally:

• Be a registered user on the IBM Rational Software Support Web site. For 
details about registering, go to http://www.ibm.com/software/support/.

• Be listed as an authorized caller in the service request tool.
IBM Rational Change Installation Guide  3

http://www.ibm.com/software/rational/support/telelogic/
http://www.ibm.com/software/rational/support/telelogic/
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html
http://www.ibm.com/software/lotus/passportadvantage/brochures_faqs_quickguides.html
http://www-01.ibm.com/software/support/
http://www-01.ibm.com/software/support/
http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html
http://www.ibm.com/software/lotus/passportadvantage/howtoenroll.html


Chapter 1: Introduction
Submitting problems
To submit your problem to IBM Rational Software Support:

1. Determine the business impact of your problem. When you report a 
problem to IBM, you are asked to supply a severity level. Therefore, you 
need to understand and assess the business impact of the problem that you 
are reporting.

Use the following table to determine the severity level.

2. Describe your problem and gather background information, When 
describing a problem to IBM, be as specific as possible. Include all relevant 
background information so that IBM Rational Software Support specialists 
can help you solve the problem efficiently. To save time, know the answers to 
these questions:

• What software versions were you running when the problem occurred?

To determine the exact product name and version, use the option 
applicable to you: 
• Start the IBM Installation Manager and select File > View Installed 

Packages. Expand a package group and select a package to see the 
package name and version number. 

• Start your product, and click Help > About to see the offering name and 
version number. 

Severity Description

1
The problem has a critical business impact: You are unable to 
use the program, resulting in a critical impact on operations. 
This condition requires an immediate solution.

2 This problem has a significant business impact: The program 
is usable, but it is severely limited.

3
The problem has some business impact: The program is 
usable, but less significant features (not critical to 
operations) are unavailable.

 4
The problem has minimal business impact: The problem 
causes little impact on operations or a reasonable 
circumvention to the problem was implemented.
4 IBM Rational Change Installation Guide



Contacting IBM Rational Software Support
• What is your operating system and version number (including any 
service packs or patches)? 

• Do you have logs, traces, and messages that are related to the problem 
symptoms? 

• Can you recreate the problem? If so, what steps do you perform to 
recreate the problem? 

• Did you make any changes to the system? For example, did you make 
changes to the hardware, operating system, networking software, or 
other system components? 

• Are you currently using a workaround for the problem? If so, be 
prepared to describe the workaround when you report the problem.

3. Submit your problem to IBM Rational Software Support. You can submit 
your problem to IBM Rational Software Support in the following ways:

• Online: Go to the IBM Rational Software Support Web site at https://
www.ibm.com/software/rational/support/ and in the Rational support 
task navigator, click Open Service Request. Select the electronic 
problem reporting tool, and open a Problem Management Record 
(PMR), describing the problem accurately in your own words.

For more information about opening a service request, go to http://
www.ibm.com/software/support/help.html.

You can also open an online service request using the IBM Support 
Assistant. For more information, go to https://www.ibm.com/
software/support/isa/faq.html.

• By phone: For the phone number to call in your country or region, go 
to the IBM directory of worldwide contacts at http://www.ibm.com/
planetwide/ and click the name of your country or geographic region. 

• Through your IBM Representative: If you cannot access IBM 
Rational Software Support online or by phone, contact your IBM 
Representative. If necessary, your IBM Representative can open a 
service request for you. You can find complete contact information for 
each country at http://www.ibm.com/planetwide/.
IBM Rational Change Installation Guide  5
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2 Terms and Concepts
To perform the operations described in this guide, you should first understand the 
following Rational Change terms and concepts:

central CR database A central CR database contains change requests (CRs) 
only. These CRs might be associated to tasks in 
multiple development databases. The central CR 
database is connected directly to the central server. 
There is only one central server and one central CR 
database in a cluster. 

central server A central server stores CRs in the central CR database. 
Remote development databases and the central server 
can be linked using remote servers. There should be 
only one central server. See “Server Modes and Types” 
on page 15. 

change request A change request is a database object used to track 
problem or enhancement requests. 

development database A development database contains tasks and objects (as 
opposed to CRs). It can be connected directly to a 
central server or indirectly through a remote server. If 
it is connected to a remote server, it is known as a 
remote development database. 

Jetty Web server The Jetty Web server is bundled with the delivered 
product. 

local admin user The local admin user, which replaces the ChangeAdmin 
user from previous releases, is a special Rational 
Change user account that is defined during 
installation. Unlike regular user accounts, the local 
admin user is authenticated by Rational Change 
directly, rather than by the IBM® Rational® Directory 
Server (RDS), and is used to perform certain 
background activities. See “Installing Rational 
Change” on page 35. 
IBM Rational Change Installation Guide 7



Chapter 2: Terms and Concepts
Rational Synergy
back-end session A Rational Synergy back-end session is used by Rational 

Change to carry out database operations for each user 
logged in to Rational Change. Rational Synergy 
sessions can be run on the Rational Change server 
machine or any compatible machine on which 
Rational Synergy is operational. 

Rational Synergy 
database The Rational Synergy database is a repository of change 

requests for an installation of Rational Change. 

Rational Change
Login page The Rational Change Login page is where you start a 

Rational Change session. 

Rational Change server The Rational Change server is the machine on which 
Rational Change is installed. The Rational Change 
server is also used to represent the Rational Change 
Web server.

Rational Directory 
Server The Rational Directory Server (RDS) performs 

authentication and stores Rational Change user data. 

remote server A remote server is a proxy between the central server 
and remote development databases. Multiple remote 
servers can be associated with the central server. See 
“Server Modes and Types” on page 15.

stand-alone server A stand-alone server is a “traditional” server that stores 
CRs in development databases. See “Server Modes 
and Types” on page 15. 

task A task represents a unit of work that needs to be 
done, for example, in your software application. You 
can associate one or more tasks with a change 
request. A task includes a description of the unit of 
work and the user name of the person responsible for 
completing it. When a change needs to be made, 
someone in your organization creates a task. If you 
8 IBM Rational Change Installation Guide



are responsible for making the change, the task is 
assigned to you within Rational Synergy. After you 
select an assigned task, objects you check out are 
associated with that task. 

WAS This is the IBM® WebSphere® Application Server. It 
is not bundled with the delivered product but can be 
installed optionally. 

WASCE This is the IBM® WebSphere® Application Server 
Community Edition. It is not bundled with the 
delivered product but can be installed optionally. 
IBM Rational Change Installation Guide  9
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3 Product Requirements
This chapter lists the requirements for the Rational Change server host and the 
Rational Synergy server:

• “Rational Change server machine” on page 12

• “Rational Synergy session machine” on page 13

• “Rational Change client host machine” on page 13

For the latest hardware requirements and for the latest supported versions of the 
software requirements, see the Readme.
IBM Rational Change Installation Guide 11
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Chapter 3: Product Requirements
Rational Change server machine
The following requirements are for the host that will run the Rational Change 
server.

Hardware requirements

The hardware requirements for each host running a Rational Change server are 
described in the Readme.

Software requirements

The software requirements for each host running a Rational Change server are as 
follows:

• One of the supported operating systems must be installed and operational on 
the server. For information about supported platforms, see the Readme.

• Rational Synergy must be installed and operational. For detailed information 
about installing Rational Synergy, see the IBM Rational Synergy Installation 
Guide for Windows®, located in the Rational Software Information Center.

• The IBM® Rational® License Server TL must be installed and operational. 
For information about the license server, including when and how to install 
it, see the IBM Rational License Server TL Guide.

• RDS 5.0 must be installed and operational. See the IBM Rational Directory 
Server Product Manual, or the Help for information about RDS, including 
when and how to install it.

• If you are using Rational Change by itself, you can use IBM® RDS 5.0 
for Apache, which takes up less disc space and is not as complex to 
install.

• If you are using the IBM® Rational® Change for DOORS® Interface, 
you must use IBM® RDS 5.0 for Tivoli.

For information about upgrading from older versions of RDS, see the “Data 
Migration” chapter in the IBM Rational Directory Server Product Manual or see 
the Help.

• The person installing Rational Change must be in the local Administrators 
group.
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Rational Synergy session machine
Rational Synergy session machine
The following requirements are for a Rational Synergy session host, which runs 
Rational Synergy sessions for Rational Change. You can run Rational Synergy 
and Rational Change on the same machine.

Note  For maximum performance, run Rational Synergy sessions 
on the database server.

If you are using a UNIX repository (Rational Synergy database), see “Installing 
on Windows with a UNIX Rational Synergy database” on page 72.

Hardware requirements
The hardware requirements for each host running a Rational Synergy session are 
described in the Readme.
If you expect a large number of users for your Rational Change installation, you 
can increase capacity by dedicating additional Rational Synergy session hosts. 
You can do so later by logging on to a Rational Change session using the Admin 
interface and changing the host settings on the Administration action Server 
tab.

Software requirements
The software requirements for each host running a session are as follows:

• One of the supported operating systems must be installed and operational 
on the server. For information about supported platforms, see the Readme.

• Rational Synergy must be installed and operational. For detailed information 
about installing Rational Synergy, see the Rational Synergy Installation Guide for 
Windows, located on the Rational Software Information Center.

• The person installing Rational Change must be in the local Administrators 
groups.

You must install the Rational Synergy server on each host on which Rational 
Synergy sessions will run.

Rational Change client host machine
A Web browser must be installed and functioning properly on the client host.
For the most current information about supported operating systems and 
browsers for Rational Change, see the Readme.
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4 Server Modes and Types
This chapter discusses the Rational Change server modes and types. Because the 
server type cannot be changed once it has been installed, read this section before 
installing the product.
This chapter includes the following topics:

• “Modes of operation” on page 15

• “Central mode server types” on page 17

• “Choosing a server type” on page 18

• “Determining whether to upgrade from a stand-alone to a central server” on 
page 18

Modes of operation
Rational Change supports two modes of operation:

• Stand-alone

• Central 
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Stand-alone mode
In stand-alone mode, CRs are stored in development databases connected to the 
server. To access a CR, a user must log on to the database where the CR is stored. 
To establish a CR-task relationship, both items must be in the same database. The 
available databases are limited to the ones available to a particular Rational 
Synergy server on which Rational Change depends. This is the way it worked 
prior to the 5.0 or earlier release.
The following diagram shows the stand-alone Change server setup.

Central mode
In central mode, all CRs are stored in the central CR database, which is a 
repository exclusively for CRs. Because Rational Change is always implicitly 
connected to the central CR database, a user can log on to any database within 
the central server cluster and still have access to all CRs. CR-task relationships are 
not restricted by the location of either item. In addition, the databases in the 
central server cluster can span the Rational Synergy servers and can be in 
geographically disparate regions.
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Central mode server types
There are two complementary server types in the central mode: central and 
remote. Within a central server cluster, there is always a single central server and 
zero or more remote servers. Each server, regardless of its type, can host 
multiple databases. The central server hosts the central CR database and, 
optionally, other databases. It is the only server end-users interact with. 
A remote server acts as a proxy between the central server and remote 
development databases. A remote server is needed when you want databases that 
are hosted by different Rational Synergy servers to be part of the central server 
cluster.

Consider this example, using the figure above. A company has its headquarters in 
San Francisco (Central Change Server) and offices in Madrid and Berlin 
(Geographic Regions 1 and 2, above). This company has Rational Synergy 
databases in each geographic region, each hosted by a Rational Synergy server 
per city. The central server and the central CR database are located in San 
Francisco and are able to communicate with the databases in Madrid and Berlin 
through a remote server located in each city. In this deployment situation, there 
is a central server and two remote servers. All users access Rational Change 
through the central server (not a remote server) and have access to all CRs, 
regardless of the database they are logged on to for task work.
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Choosing a server type
The server type (stand-alone, central, or remote) is designated at the time of 
installation and cannot be changed thereafter. See “Installing Rational Change” 
on page 31.
Stand-alone servers work independent of each other, whereas a central server and 
its corresponding remote servers work together to form the central CR cluster. 
The order in which you install the central and remote servers is not a concern as 
they are linked together as a post-installation step. See “Connecting the central 
and remote servers” on page 51.

Determining whether to upgrade from a stand-alone to a central 
server

To upgrade from a stand-alone server to a central server, you need to:

• Select a central CR database.

• Migrate all existing CRs into the central CR database.

A central server offers many benefits, which are mentioned above. However, 
sometimes it is not the correct choice for all users.

Caution  Make sure you read this entire section so that you 
understand all of the caveats before upgrading to a central 
server. Once you have upgraded, you cannot revert to a 
stand-alone server.

You should not use a central server if you use:

• Certain nested queries

In central server mode, CRs and tasks are stored in separate databases, which 
impact the types of queries you can run on the different databases. When you 
know where objects are created, you understand on which queries you can 
rely.

Your central CR database contains only CRs. As a result, you cannot use 
query strings that bridge the relationship from CRs to tasks. For example, the 
following query string would not return accurate results:
has_associated_task(cvtype='task' and release='1.0') and 
crstatus=’assigned’

Queries in your development databases are not as limited. Although CRs are 
not created in development databases, ghost CRs, which are non-modifiable 
copies of CRs with subsets of their real CR attributes, are created in the 
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development database. Ghost CRs primarily exist to allow CR-based Update 
Members queries from Rational Synergy. When a task is associated to a CR, a 
ghost CR is created in all the development databases where that task is 
found. The ghost CR is directly related to the task to support most nested 
queries in those databases.

A ghost CR acts as a stand-in for the real CR. Rational Change automatically 
maintains ghost CRs so that they always reflect their corresponding real CRs. 
The attributes that are created on them can be controlled through the 
Rational Change Admin interface and should normally be agreed upon with 
your Rational Synergy build managers. With ghost CRs, a Rational Synergy 
Task Folder, in a development database, could still rely on a query, such as 
the following:
is_associated_task_of(cvtype='problem' and release='1.0' and 
crstatus='resolved')

With ghost CRs, you can continue to use most CR-to-task nested query 
strings for CR-based Update Members. However, they have limitations. 
Ghost CRs only maintain the attributes they have been told to sync, though 
you can sync as many attributes as needed for your queries. They do not 
maintain any relationships beyond associated_task, and they only exist 
for CRs that have associated tasks. Besides their use in Update Members, 
ghost CRs can also be queried for through the Rational Synergy CLI, but 
they cannot be edited there.

Most other ways of traversing between CRs and associated tasks continue to 
work as always, including Queries and Reports using report formats with 
associated tasks, Relationship Reports to associated tasks, the associated 
tasks control on Show Forms, and the Change Requests Explorer in Rational 
Synergy. 

• The Rational Change for DOORS Interface

The Rational Change for DOORS Interface does not support transferring 
CRs between databases. If you are already using this product, you cannot 
migrate your existing CRs to a central CR database. If you do not currently 
use the interface, you can use the interface after you upgrade to a central 
server.

• The CreateMiscObject API

The misc objects created by this API cannot be transferred to other 
databases. If you have used this API to create misc objects related to CRs, 
you must first delete those objects or unrelate them from your CRs. 
Otherwise, you cannot migrate your existing CRs to a central CR database.
IBM Rational Change Installation Guide  19



Chapter 4: Server Modes and Types
• Uncommon CR relationships

When you migrate, your existing CRs, the CRs, and their directly related 
objects are transferred to your central CR database. If any of those objects 
must remain in their current development databases, do not migrate. 
Normally, CRs are only directly related to other CRs, attachments, and tasks. 
This setup is safe to migrate. However, if you have created any direct 
relationships from CRs to other objects, those objects would be incorrectly 
transferred. Examples of unsupported relationships that do not work in a 
central server include:

• CRs directly related to source files (for example, Java™, Visual C++®, 
Perl, and so forth). Source files should only be related to tasks.

• CRs directly related to projects or directories.
• CRs directly related to baselines.

Rational Synergy has features to show which CRs are included in a 
baseline. These features do not rely on relationships and continue to 
work in central server mode.

• Relationships from non-CRs to CRs.

Selecting a central CR database

In a central server, all CRs live in a single, central CR database so you can view, 
modify, and report on CRs without switching databases. This database is 
dedicated to CRs. Your tasks and objects are kept in separate development 
databases, but with Rational Change, you can associate CRs in your central CR 
database to tasks in any of the your development databases. Before installing 
Rational Change, decide which database will be your central CR database. You 
select it during the installation process, see “Installing Rational Change” on page 
31, and you cannot change it later.
In most cases, you unpack a new, empty database to be your central CR database. 
This ensures that there are no development objects, such as tasks or source files, 
in the database. Then, you can transfer all existing CRs into that database with 
the CR migrate feature. See “Performing a CR migrate” on page 62.
Alternatively, you can designate an existing, non-empty database as your central 
CR database. You should do this only when you have a database completely 
dedicated to CRs. For example, you initially submit all CRs into one database and 
use Rational Synergy Distributed, also called Distributed Configuration 
Management (DCM), to transfer them to other databases before associating 
tasks. If you have any tasks or objects, anything other than CRs and their 
attachments, in that initial database, they might become inaccessible or damaged 
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in a central server. The advantage of using an existing database is that it might 
speed up migration if most of your CRs are already modifiable in that database.

Understanding how a central server changes data
This section discusses how the central server affects the following:

• “Database queries, specific reports, and preferences” on page 21

• “Change requests” on page 21

Database queries, specific reports, and preferences

Queries, reports, report formats, and preferences are no longer database specific. 
You see the same sets of these items no matter which development database you 
log on to. Existing items in your development databases are automatically 
transferred to your central CR database. You do not need to explicitly migrate 
them.
If there are name conflicts between items in different databases, the conflicting 
items are automatically renamed. For example, if one development database used 
to contain Report A and Report B, and another contained Report B and Report 
C, after upgrading to a central server, your central CR database contains Report 
A, Report B, Report B (2), and Report C.

Change requests

If you are converting an existing database into to your central CR database, the 
CRs are not affected.
However, the CRs in your development databases are not initially visible in a 
central server. To make them visible, migrate them to the central CR database, 
see “Performing a CR migrate” on page 62.
When migrating CRs from a development database, the system:

• Transfers all CRs from a development database to the central CR database.

All CRs that are local to the development database are transferred to the 
central CR database and made local. Their modifiable_in attributes are 
changed. In some cases, non-modifiable copies of the CRs remain in the 
development database, but you should assume that CRs will be deleted from 
that development database. Non-local CRs are skipped. You must migrate 
their development databases separately to transfer them.
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• Transfers all CR attachments and other directly related objects to the central 
CR database.

If you have any objects associated to CRs that should not be transferred to 
the central CR database, you should not migrate. See “Determining whether 
to upgrade from a stand-alone to a central server” on page 18.

• Preserves your CR-to-CR relationships.

These relationships remain intact in your central CR database. If you have 
CRs related to non-local CRs because you previously used DCM, the non-
local CRs are not be migrated yet and do not show up as related CRs. When 
the databases that they are local to are migrated, then the CRs and 
relationships show up.

• Preserves CR-to-task associations.

Associated tasks and their associated objects remain in the development 
database, but the relationships from CRs to tasks are preserved. When a CR 
with associated tasks has been migrated, you can see its original associated 
tasks.

If you have determined that you should upgrade from a stand-alone server to a 
central server, see “Planning the upgrade from a stand-alone server to a central 
server” on page 57 for instructions.
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5 Selecting a Change Request Process
This chapter provides a high-level overview of the available change request 
processes to help you determine which process package to install.
For additional information about the different processes, see the IBM Rational 
Change Process Guide, located at http://publib.boulder.ibm.com/infocenter/rsdp/
v1romo/index.jsp.

Development process
The development process, contained in the dev_process.xml file, is a 
methodology for tracking CRs as they transition from being entered into the 
system to being resolved. The development process provides a basic software 
development change management lifecycle and is a good starting point for first 
time users.
Ultimately, the CR is either concluded successfully, marked as a duplicate of 
another change request, made obsolete, or rejected. The possible transitions and 
states for the development process are shown in the following figure.
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Benefits
The development process provides the following benefits:

• You can start with this process and, at a later time, customize it and make 
modifications based on your needs.

For customization information, see the “Add or Change a CR Lifecycle” 
section of the Rational Change Admin Help.

Features
The following are the development process features:

• Optional interlocked requirements change management

• Change request resolution management

• Easy-to-use notifications

Enterprise Change Process
The Enterprise Change Process (ECP), contained in the ECP_process.xml file, 
provides an efficient and systematic enterprise-wide approach to change 
management. With ECP, you can monitor when defects are introduced and 
discovered. By analyzing this data, you can reduce development costs and 
improve product quality by finding defects closer to when they are introduced.

Benefits

ECP provides the following benefits:

• Scales to support change management needs for large or small enterprises, 
for straight forward or complex change requests.

• Optionally includes management and change of requirements, using IBM® 
Rational® DOORS®.

• Optionally supports requirements-driven development through creation of 
change requests directly from requirements and requirements-related 
documentation, using Rational DOORS.
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Enterprise Change Process
Features
The following are ECP features:

• Five phase: submission, analysis, resolution, evaluation, and conclusion

• Extensible stages, both depth and breadth

• Optional interlocked requirements change management

• Change request resolution management

• Reports, which are ready-to-run and do not require calculation, that help 
support high maturity Capability Maturity Model Integration® and Six 
Sigma®

• Easy-to-use notifications
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6 Worksheet
To make your installation easier, print a copy of the worksheet and document 
information for all possible items before starting. Then, use this work sheet to 
document other items during the installation. Save the worksheet after completing 
the installation. You might need it for upgrades.
This worksheet contains multiple server installations. Use the appropriate 
information for your installation. All items apply to the Jetty, WAS and WASCE 
installations, unless otherwise noted.

1. Rational Change installation directory (CHANGE_HOME)

Directory into which Rational Change is installed.
Use Default: C:\Program Files\IBM\Rational\Change\5.2

Use Value: __________________________________ 

2. Local admin user (admin)

User account that is authenticated by Rational Change and is used to perform 
certain background activities.
Use Default: admin
Use Value: __________________________________ 

3. Host server name (server_name)

Name of the host running the Rational Synergy session.
Use Default: Name of local host
Use Value: __________________________________ 

4. License server (port@host)

Server that validates product licenses.
Use Default: 19353@hostname

Use Value: __________________________________ 

5. Server port number (port)

Port number for the Rational Change server. For Jetty, if you have an existing 
Rational Change installation, select a different port number for this 
installation.
Use Default: 8600
Use Value: __________________________________ 
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6. Context (context)

Web-context on which the Rational Change application runs.
Use Default: change
Use Value: __________________________________ 

7. WebSphere profile (was_profile)

For the WAS installation, collections of user files that share core product 
files. A profile contains its own set of scripts, environment, and repository.
Use Default: AppSrv01
Use Value: __________________________________ 

8. WebSphere admin user (was_admin user or wasce_admin user)

Admin credentials for the WAS or WASCE server. This information is used 
to start the application.
Use Default:
Use Value: __________________________________ 

9. WebSphere server instance (was_server instance)

For the WAS installation, represents an instance of the application server on 
which the application will be deployed and run. Multiple server instances can 
exist for a profile. Each server instance has its own memory space allocated 
in the server JVM, which it uses for application management. Multiple 
applications can be deployed on a single server instance.
Use Default: myServer
Use Value: __________________________________ 

10. Rational Synergy installation directory (ccm_home)

Path to the Rational Synergy installation to use for Rational Synergy back-
end sessions. This path must be visible to all hosts used for Rational Synergy 
back-end sessions.
Use Default: Retrieved from registry setting
Use Value: __________________________________

11. Rational Synergy database path (database_path)

UNC path to a Rational Synergy database. This database must be at the same 
release level as the Rational Synergy installation at ccm_home.
Use Default: None
Use Value: __________________________________ 
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12. Rational Synergy Session User (cm_session_user)

Operating system (OS) user that runs back-end sessions. This user must be 
defined in the operating system and be a user in the database. See “Creating 
a Rational Synergy session user in the OS” on page 33 and “Defining the 
Rational Synergy session user in the database” on page 34.
Use Default: csuser
Use Value: __________________________________ 

13. Local database path (local_database_path) 

Windows local path to a UNIX Rational Synergy database. It can be any 
directory accessible to the Rational Change server. Set this location using -u 
database in the Optional Arguments box on the Administration action 
Server tab.
Use Default: None
Use Value: __________________________________ 

14. Configuration files directory (config_dir)

Subdirectory where Web application files are copied.
Use Default -Jetty: CHANGE_HOME\jetty\webapps\context\

WEB-INF\wsconfig

Use Default - WAS: CHANGE_HOME\context.ear\context.war\

WEB-INF\wsconfig

Use Default - WASCE: CHANGE_HOME\context\WEB-INF\wsconfig

Use Value: __________________________________

15. Mail server host (mailserver_host)

Host that runs the mail server. 
Use Default: None
Use Value: __________________________________

16. Rational Directory Server URL(RDS_URL)

URL for a RDS installation.
Use Default: ldap://localhost:1389

Use Value: __________________________________
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7 Installing Rational Change
To install Rational Change, perform the following steps:

1. “Unpacking a database and preparing it for use” on page 32

2. “Creating a Rational Synergy session user in the OS” on page 33

3. “Defining the Rational Synergy session user in the database” on page 34

4. “Installing Rational Change” on page 35

5. “Preparing Rational Change for use” on page 52

6. “Updating Rational Synergy mail triggers” on page 53

To avoid installation failure, when installing Rational Change on WAS or WASCE, 
the user who installed WAS or WASCE should be the user who installs Rational 
Change.
To make your installation easier, use the “Worksheet” on page 27. Print out and 
fill in the worksheet before starting the installation.
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Unpacking a database and preparing it for use
A database is required when installing Rational Change. Use the following 
information to determine whether an existing database can be used during 
installation:

• Stand-alone—unpack a new database or use an existing one.

• Central—unpack a new database or use an existing one.

• Remote—unpack a new database or use an existing one.

If your database has existing CRs, migrate them. See “Performing a CR 
migrate” on page 62

For a detailed discussion about stand-alone and central servers, see “Server 
Modes and Types” on page 15.

• If you are using an existing database, skip this section and go to 
“Defining the Rational Synergy session user in the database” on page 34.

• If not, follow the steps below to unpack a Rational Synergy database 
(that is, unpack base.cpk from the Rational Synergy installation 
directory packfiles directory).

1. Log on as the Rational Synergy administrator on the database server 
machine.

2. From the Windows Explorer Start menu, select All Programs > IBM 
Rational > IBM Rational Tools > IBM Rational Synergy 7.1 > CM 
Command Prompt to start a Rational Synergy command window.

3. Unpack a Rational Synergy 7.1 database to database_path (item 11 on your 
worksheet). Also, be sure to use the UNC path for the database_path.
> ccmdb unpack %CCM_HOME%\packfiles\base.cpk /to 
database_path
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Creating a Rational Synergy session user in the OS
You must define the Rational Synergy session user in the OS. Rational Change 
uses the Rational Synergy session user name to run back-end Rational Synergy 
sessions. Use csuser, which is predefined in the Rational Synergy 7.1 database.

Note  For security and logging reasons, do not use the Rational 
Synergy administrator as the Rational Synergy session user. 
However, if you are having trouble creating an OS user 
account, you can use the Rational Synergy administrator 
temporarily. Later, you can use the Admin interface to change 
the Rational Synergy session user and other server values.

1. Contact your system administrator to add a new OS user. This user must 
have the same domain as the Rational Synergy administrator, be able to log 
on locally to the machine running Rational Synergy sessions, and able to 
send email.

2. Add the entry for the Rational Synergy Session User (item 12 on your 
worksheet).
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Defining the Rational Synergy session user in the database
If csuser is defined as the Rational Synergy Session User, skip this section and go 
to “Installing Rational Change” on page 35. If not, follow the steps below to 
define the Rational Synergy session user for each database.

Note  The user csuser is predefined in the Rational Synergy database. 
If you are not using this user name, remove the entry from 
the list of valid database users.

1. Log on as the Rational Synergy administrator.

2. From the Windows Explorer Start menu, select All Programs > IBM 
Rational > IBM Rational Tools > IBM Rational Synergy 7.1 > CM 
Command Prompt to start a Rational Synergy command window.

3. Start a Rational Synergy session from the command line.
> ccm start -d database_path -r ccm_admin

4. Open the users file.
> ccm users

5. In the users file, add the entry for the Rational Synergy Session User (item 12 
on your worksheet).
user username = no_privs;

6. Save and close the file.

7. Exit the Rational Synergy session.
> ccm stop
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Installing Rational Change
To install Rational Change, follow the steps below, in the order listed.

1. “Installing the software” (see below).

2. “Verifying the Rational Change installation” on page 50

Installing the software

To install the Rational Change software:

1. Log on as a user with administrative privileges.

2. Run the Rational Change server installation command.

Note  If you are running the installation command in 
command-line mode, a 1.6 JRE must be in the system 
path. Check this by typing java -version at the 
command prompt. The returned value should be:
java version "1.6.xxx" 

Use the JRE file that was shipped with Rational Synergy.

To start the installation in GUI mode, double-click the csinst.exe 
program in the dvd01\change\server\win32 directory.

To start the installation in command-line mode, run the following command 
from the dvd01\change\server\win32 directory:
> java -jar csinst.jar -nogui

When the script prompts you for values, type the values shown for the GUI 
steps.

Note  If a warning appears, your system might not meet the 
system requirements. For more information, see 
“Product Requirements” on page 11. Other reasons for a 
warning to appear might be that the installation program 
did not find the JRE or there was not enough disk space. 
For additional information, please contact Rational 
Software Support. The Home page for Rational Change 
products is located at http://www.ibm.com/software/
awdtools/change/support/.
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3. In the Software License Agreement dialog box, which follows the 
Welcome dialog box, read the license agreement information, and then click 
Accept.

4. In the Change Info - Server Type dialog box, select the applicable server 
type, and then click Next.
Click Lean More to view details about the server types or see “Server 
Modes and Types” on page 15 for more information.
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5. In the Change Info - Install Directory dialog box, accept the default path, 
or type the appropriate installation path, and then click Next.
If you change the installation directory, be sure to update item 1 on your 
worksheet for future reference.

For assistance choosing a path, click Browse.
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6. In the Change Info - Local Admin User dialog box, type the user name 
and password (item 2 on your worksheet), and then click Next.
The local admin user replaces the ChangeAdmin user from previous releases. 
For more information about the local admin user ID, see “local admin user” on 
page 7.
38 IBM Rational Change Installation Guide



Installing Rational Change
7. In the Change Info - Host dialog box, accept the default or type the name 
of the machine to run Rational Synergy sessions (this must be a Windows 
machine), and then click Next. 
For a description of this host, see “Rational Synergy back-end session” on 
page 8. 

If you change the host name, be sure to update item 3 on your worksheet. 
You can add more session hosts later.
IBM Rational Change Installation Guide  39



Chapter 7: Installing Rational Change
8. In the Change Info - License Information dialog box, select the applicable 
option (item 4 on your worksheet), and then click Next. 
If you select the “I will supply license information later” option, you are later 
reminded to edit the license data in the license_data.txt file. See step 20 
for specific details.
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9. In the Web Server Info - Choose a Web Server dialog box, select a Web 
server. Then, for Jetty, accept the default or for WAS and WASCE, type the 
location of the existing Web server installation, and then click Next.
• Jetty
• WAS
• WASCE

The dialog box looks similar to the following:
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10. In the Web Server Info - Port and Context dialog box, accept the default 
or type the port number for the Rational Change server, type a unique 
context path for Rational Change, and then click Next.
If you change the port number, be sure to update item 5 on your worksheet. 
The context is item 6 on your worksheet.

After completing this step, if you are installing into:

• Jetty, skip to step 14.
• WAS, proceed to step 11.
• WASCE, skip to step 12.

The dialog box looks similar to the following:
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11. If you are installing into WAS, in the WebSphere Profile dialog box, select a 
WebSphere profile (item 7 on your worksheet) where you want to install 
Rational Change, and then click Next.
At least one profile must exist to run the product.
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12. If you are installing into either WAS or WASCE, in the Web Server Info -
Admin User dialog box, type the WebSphere server admin ID (item 8 on 
your worksheet) and password, and then click Next.
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13. If you are installing into WAS, in the WebSphere Server Instance dialog 
box, select a WebSphere server (item 9 on your worksheet).
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14. In the Synergy Info - Directory dialog box, accept the default or type a 
path to the Rational Synergy installation (ccm_home, item 10 on your 
worksheet), and then click Next.
If you change the path to the Rational Synergy installation, be sure to update 
your worksheet.
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15. If you receive a warning message, follow the instructions in this step. If not, 
proceed to the next step.

If a warning appears about the installation path, the existing ccm_home 
installation might not be the required release of Rational Synergy. Click No 
to specify a different path to ccm_home or Yes to proceed with the 
installation using the path you already specified.

16. In the Synergy Info - Database dialog box, type the UNC path to the 
database (as indicated below), and then click Next.
• Stand-alone server—type a UNC path to a Rational Synergy database.
• Central server—type a UNC path to a DCM-initialized Rational Synergy 

central CR database.
• Remote server—type a UNC path to a DCM-initialized Rational 

Synergy development database.

If you change the database path, be sure to update item 11 on your 
worksheet. You can add more databases later.
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17. If a warning appears, the existing database might not be for the required 
release, or the path you specified might not be correct or visible. Click No to 
specify a different path to database_path or click Yes to proceed with the 
installation using the path you already specified.

Note  If you typed a UNIX path, you receive a warning 
message. For additional instructions once the installation 
has been completed, see “Installing on Windows with a 
UNIX Rational Synergy database” on page 72.

18. In the Synergy Info - Session User dialog box, type the name of the session 
user and password (item 12 on your worksheet), and then click Next. 
The user name must be defined in the operating system and be a user in the 
Rational Synergy database.
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19. In the Start Copying Files dialog box, click Install.
The Rational Change files are copied to the installation directory. As the files 
are copied, a status screen shows the progress of the installation.
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20. In the Install Wizard Complete dialog box, click Finished to exit the 
installation process.

On the Change Info - License Information dialog box, if you chose to 
specify license information later, you need to edit the license_data.txt 
file in the applicable directory:

For Jetty:
CHANGE_HOME\jetty\webapps\context\WEB-INF\wsconfig.

Note  context is the context path you specified in step 10.

For WAS:
CHANGE_HOME\context.ear\context.war\WEB-INF\wsconfig.

For WASCE:
CHANGE_HOME\context\WEB-INF\wsconfig.

You must specify that information before you can log on to Rational Change.

Verifying the Rational Change installation
Verify that the necessary services are running and that you can bring up the 
Rational Change log on dialog box.

1. For Jetty, verify that the Rational Change server Service has been started. The 
service is named IBM Rational Change NNNN, where NNNN is the port 
number assigned to this Rational Change server.

2. Verify that Rational Change is installed correctly by using your browser to go 
to the IBM Rational Change Admin Login page on the Rational Change 
server. The URL is similar to the following (using item 3 and item 5 on your 
worksheet):
http://server_name:port/context/admin

• Since you have not yet configured Rational Change to use RDS, you see the 
Configure IBM Rational Change to Use RDS page. See “Configuring 
Rational Change to use RDS” on page 51.

Note  The Rational Change server might take a few minutes to start. 
If the log on page does not appear in a few minutes, see 
install.log, located in CHANGE_HOME\install.log.
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Configuring Rational Change to use RDS
The first time you browse to the IBM Rational Change Admin Login page, 
you are prompted to configure Rational Change to use RDS. You can use the 
same RDS for remote and central servers.

1. In the Configure Rational Change to Use RDS page, in URL, type the 
correct URL.

2. In RDS Admin, type the name of the RDS admin user.

3. In Password, type the password, and then click Connect to connect 
Rational Change to RDS.

If the connection attempt should fail, an error message appears with the 
reason the connection failed.

Connecting the central and remote servers
Remote servers must be connected to the central server to participate in the 
central server cluster. It is possible to have a central server without any remote 
servers. This just means your cluster does not have any remote development 
databases (although it likely has, or will have, local development databases 
connected directly to the central server).
To connect remote servers from the central server, see “Add a Remote Server” in 
the Rational Change Admin Help.
To connect to the central server from a remote server, see “Add a Central 
Server” in the Rational Change Admin Help.
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Preparing Rational Change for use
After Rational Change has been installed, a single user, local admin, is available in 
Rational Change so that you can use the Admin interface. You must log on to 
Rational Change and install a process package before other roles can be used. 
You must also define user privileges in the database.
Perform the following steps to prepare Rational Change for use. For more 
information, click the Welcome Pages link.

1. If you are upgrading Rational Change, initialize RDS before proceeding.

For more information, see “Populating the Rational Directory Server” on 
page 57.

2. Log on to the Rational Change Admin interface as user local admin.

The following steps do not apply to the remote server.

a. Install a process package.

For example, you could use the delivered dev_process or ECP_process 
package.

For more information about process packages, see “Selecting a Change 
Request Process” on page 23.

For more information about installing packages, see the Rational Change 
Admin Help.

b. Set up users.

For more information about setting up users, see the Rational Change 
Admin Help.

When using OS authentication through RDS, the administrator must 
migrate the users into RDS. This may be done manually by recreating 
each user through RDS, or by importing users from a file. If you already 
have users defined in Rational Synergy databases, you can easily export 
them to a file through the Rational Change Admin > Users > Export 
Database Users. This file can then be imported into RDS.

c. Set up email for triggers and the subscription feature by setting the 
“SMTP Server” and “From E-Mail Address” in the “Sending E-Mail” 
section of Administration > General.

For information about using Rational Change, for terms and concepts, for dialog 
box descriptions, and for step procedures, see the Rational Change Help.
For the most recent updates to Rational Change, see the Readme.
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Updating Rational Synergy mail triggers
Rational Synergy mail triggers send email to a predefined list of users when a task 
is assigned. You must update mail triggers after installing Rational Change.
To update mail triggers for the Rational Change installation, run the 
webdb_patch script using the path CHANGE_HOME, item 10, database_path, 
item 11, and mailserver_host, item 14, on your worksheet.

1. Log on as the Rational Synergy administrator.

2. Run the mail trigger update script for each database.

For Jetty:
> CHANGE_HOME\jetty\webapps\context

For WAS:
> CHANGE_HOME\content.ear\content.war

For WASCE:
> CHANGE_HOME\context
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8 Upgrading Rational Change
There are no automatic upgrade option for previous versions of Rational Change. 
Instead, you must install Rational Change into a new directory, and then apply any 
previous customizations to the new installation.
For information about upgrading Rational Change installation, see the following 
sections:

• “Upgrade guidelines” on page 56

• “Populating the Rational Directory Server” on page 57

• “Planning the upgrade from a stand-alone server to a central server” on page 
57

• “Upgrading from a stand-alone server to a central server” on page 60
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Upgrade guidelines
To prepare for an upgrade, read the following guidelines before installing 
Rational Change.

• Ensure that you have installed RDS 5.0. For information about installing the 
RDS, see the IBM Rational Directory Server Install Guide.

• If you are using Rational Change Distributed, see the Rational Synergy Upgrade 
Instructions for information about Rational Synergy Distributed compatibility.

• You can upgrade customizations performed using the Lifecycle Editor by 
copying your XML file to the new Rational Change 5.2 cr_process 
directory, loading the XML file, and following the instructions in the popup 
dialog box. In most cases, all that is required is saving the XML file, creating 
the package, and then installing the package.

• You can also upgrade a customization that was made manually. However, 
depending on the extent of the customization, additional work might be 
required to make it compatible with Rational Change 5.2.

Save your manual customizations in a package template. If you have done so, 
you can copy your package template into the Rational Change 5.2 
package_templates directory and use the package template to re-create 
your package.

• You must apply customizations that were made in the ptcli.cfg file.

In version 5.2, this file is located in:

For Jetty:
CHANGE_HOME\jetty\webapps\context\WEB-INF\wsconfig

For WAS:
CHANGE_HOME\context.ear\context.war\WEB-INF\wsconfig

For WASCE:
CHANGE_HOME\context\WEB-INF\wsconfig

In prior versions, the file is located in:
CCM_HOME\etc

• Pre- and post-transition TRELATIONs are no longer supported. Their 
functionality can be duplicated with bean scripting framework (BSF) trigger 
scripts, found in the wsconfig/triggers directory. Although the built-in 
TRELATIONs are automatically mapped to the replacement BSF scripts 
when the CR process is upgraded, other TRELATIONs might require 
manual replacement.
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Populating the Rational Directory Server
• If you are upgrading from version 4.7 or older, attribute controls (for 
example, base.CCM_LISTBOX) were significantly updated in Rational 
Change 5.0. Most of the JavaScript™ that previously existed in the controls 
has been extracted into the file ctrlUtils.js, which is included on base 
templates. While an effort was made to preserve backward compatibility, 
certain types of customizations, such as interdependent controls, must be 
manually upgraded.

Populating the Rational Directory Server
Rational Change stores user profile information in the RDS. 
For information about migrating from older versions of RDS, see the Rational 
Directory Server Product Manual or the Rational Change Help.

Planning the upgrade from a stand-alone server to a central server
Before you continue with this section, make sure you have read “Determining 
whether to upgrade from a stand-alone to a central server” on page 18 so that 
you understand all of the caveats before upgrading to a central server.

Caution  Once you have upgraded, you cannot revert to a stand-
alone server.

Remote servers

A Rational Change remote server acts as a bridge between a central server and 
remote development databases. A remote server is needed when you want 
databases that are hosted by different Rational Synergy servers to be available to 
your central server. Each remote server can potentially be paired with a different 
Rational Synergy server. By registering your remote servers with your central 
server, you give the central server access to all of the development databases 
those remote servers can access. Also, with remote servers, Rational Change can 
access more development databases. Users only need to log on to the central 
server. All CRs are stored in the central CR database.
When planning your upgrade, plan on one remote server for each additional 
Rational Synergy server. Remote servers can be installed on any host that can be 
reached from the central server over HTTP or HTTPS.
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Required space for CRs
Before you upgrade, run the ccm cr_summary Rational Synergy command for 
each development database you want to migrate into your central CR database. 
This command provides the number of objects that will be migrated to your 
central CR database and an estimate of the space that database requires. Knowing 
this ensure there is enough free space in the following locations:

• The Rational Change installation area

While migrating CRs, each of your Rational Changes installations need a 
minimum of 500 MB of free space. If the underlying Rational Synergy 
installations are on different file systems, there should be 500 MB of free 
space on those as well. This space is used to hold temporary copies of CRs 
while migrating and should be large enough to accommodate about one 
hundred CRs, plus their tasks and attachments, at the same time.

• Database server space

Your database server holds information about CRs and their related objects. 
To determine the amount of space needed, use the total object count from 
your cr_summary output. If you are migrating multiple databases, sum the 
totals from each database. For every 1,000 objects in your total, you need 
about 5 MB of database server space. For example, if your total is 11, 500 
objects, round up to 12, 000. You need about 60 MB (12,000/1000 x 5 MB = 
60 MB). Use the ccmsrv expand command to increase your database server 
space. This command is located in your Rational Synergy installation.

• File system space

The file system where your central CR database is located (for example,
\vol\ccmdb\central_cr_db) needs enough free space to accommodate all 
the attachments you will migrate. The total size (MB) of your attachments is 
listed in your cm_summary output. If you are migrating multiple databases, 
sum the sizes from each database.

Overestimating the amount of space needed ensures that the CR migrate will be 
completed. It also allows for future growth of the central CR database.
58 IBM Rational Change Installation Guide



Planning the upgrade from a stand-alone server to a central server
Existing DCM Transfer Sets
While in central server mode, do not use DCM to transfer CRs between 
databases. Remove CRs from all of your DCM transfer sets in Rational Synergy 
by setting the CR Scope of your transfer sets to None and deleting their CR 
Query strings. You should also remove the modifiable_in attribute (Work In 
DB) from the show and transition forms of your existing, stand-alone Rational 
Change servers to prevent users from trying to transfer CRs before a CR 
migrate. Or you can remove the databases to be migrated from those servers.
Receiving all outstanding DCM transfer packages before you migrate your CRs 
ensures that no CRs are in transit between databases when you perform a CR 
migrate. If you later realize that you missed some CRs that were in transit, you 
can always migrate the database again to pick up the remaining CRs.
When you turn off CR transfers between your new central CR database and 
remote databases, consider what other data will continue to be transferred 
between the databases, and update your DCM transfer sets and scripts 
accordingly. For example, if you centrally administer releases and process rules, 
you need transfer sets and DCM scripts to continue maintaining that process, 
even after you turn off the transfer of CRs. For a discussion on the replication of 
releases, processes, and templates, see the “Advanced DCM Topics” chapter of 
the IBM Rational Synergy Distributed Guide, located at http://
publib.boulder.ibm.com/infocenter/rsdp/v1r0m0/index.jsp.
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Upgrading from a stand-alone server to a central server
To upgrade to a central server, you need to install a new copy of Rational Change. 
If you will continue to run your previous server in stand-alone mode, remove any 
databases from that server before adding them to your central server. This 
document gives you an overview of the steps necessary to install and setup a 
central server cluster. For more detailed installation instructions, see the Rational 
Change Help.

Prerequisites
Before upgrading to a central server, ensure that the:

• Databases are DCM initialized and DCM compatible with each other.

Your central CR database and the development databases you will use with it 
must all be DCM initialized with unique database IDs. Additionally, you can 
only migrate databases that are DCM compatible with your central CR 
database. For example, your development databases must have the same case 
setting, LOWER or PRESERVE. For more details, see the IBM Rational 
Synergy Distributed CM Guide.

• System clocks are synchronized.

If you are migrating from a remote Rational Change server on a different 
host than the central server, the system clocks of the two hosts must be 
synchronized.
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Installing and setting up the central server
To install and set up the central server:

1. Install Rational Change.

During installation, when prompted, select Central Server.
For your database, type the path to the central CR database you selected in 
“Selecting a central CR database” on page 20. You cannot change this 
database later.

2. Optionally, install Rational Change remote servers.

• If you will access any of your development databases using remote 
servers, proceed to the next step to connect those servers now.

• If not, skip to step 4.

3. Connect your central server and remote servers.

On each remote server, log on to the Admin interface. Click the 
Administration link in the panel. Navigate to the Server tab, the Central 
Server sub-tab, and click Register. Type the HTTP or HTTPS address of 
the central server. This can also be done from the central server.

4. Add development databases.

Log on to your central server. Click the Administration link in the panel, 
and then navigate to the Server tab. Add your development databases that 
are local to the central server. Repeat this for each remote server and the 
development databases that are local to them.

At this point, a functional central server is connected to its development 
databases, and, optionally, the development databases of your remote servers. 
You can submit new CRs and associate them to tasks in any of the development 
servers, but you cannot see any pre-existing CRs from those development 
databases. To access those CRs, migrate them into your central CR database. For 
instructions, see “Performing a CR migrate” on page 62.
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Performing a CR migrate
Before starting this procedure, note that CR migrate can take a long time to 
complete, sometime hours or even days for very large databases. Also, any DCM 
packages received while CR migrate is in progress can dramatically extend this 
time.
To perform a CR migrate:

1. Back up your databases.

Be sure you have a full backup of your central CR database and the 
development database that you want to migrate.

2. Log on to the Admin interface.

If you have one or more remote servers, log on to the server that manages 
the development database from which you wish to migrate.

3. Open the CR Migrate window.

a. Click the Administration link in the panel.

b. Click the Admin tab.

c. In Properties, click CR Migrate.

4. Select the database to migrate.

All of your development databases managed by this server are listed in a 
drop-down menu. Select the database containing the CRs you want to 
migrate.

5. Optionally, type an email address.

Since migration can take a long time, you can request email notification of its 
completion. If your central server is configured to send email through an 
SMTP server, check the E-Mail When Done option. If your email address 
is incorrect, type the correct address.

6. Start the migrate.

Click Migrate. If no errors occur, the CR migrate continues without any 
further intervention.

During the migrate
During the migrate, you can monitor its progress using the CR Migrate dialog 
box. Closing the dialog box does not stop the migrate. Reopen the CR Migrate 
dialog box at any time to check its current progress. To stop the migrate, click 
Stop. You can restart the migrate later by migrating the same database again. 
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Rational Change resumes from where you last stopped. A migrate can also be 
resumed if it fails midway due to a network problem or other error.
Users can use Rational Change during a CR migrate. Both the central CR 
database and the development database can remain enabled. As CRs are 
migrated into the central CR database, they are immediately available for users to 
view and edit, even before the entire migrate is complete. The newest CRs are 
transferred first.
After the migrate
After the CR migrate has finished, run the ccmdb update_statistics 
command to optimize your central CR database. This command can be run in 
the middle of a CR migrate. If you suspect the migrate is getting slower as it 
progresses, running this command in the background might improve 
performance.
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Troubleshooting
The section discusses some common issues that can occur during the migration 
and provides possible solutions.

• The CR migrate failed.

If CR migrate fails because of a transient problem (such as a network failure, 
a server restart, and so forth), re-migrate the failed database. Rational Change 
continues the process where the failure occurred. CRs that were already 
migrated are preserved.

If the failure is not self-correcting, see the log files for more details. CR 
migrate uses Rational Synergy DCM technology to migrate your CRs, and, in 
many cases, the Rational Synergy and DCM related logs contain the most 
detailed information. The ccm_ui.log files for your Rational Change 
servers often describe failures in enough detail to resolve them. For even 
more details, including listings of every migrated CR, see the detailed DCM 
logs, which are in the database dcm/log directories. Depending on when the 
failure occurred, you might need to consult the logs in either your 
development or central CR database.

• Not all of the databases are DCM compatible.

A few DCM compatibility checks can be disabled during CR migrate, 
specifically the checks for compatible version delimiters and release 
delimiters. If you are already running in a DCM environment where you 
know these checks can be safely ignored, disable them by creating the 
following file in your Rational Change central server installation area:

For Jetty:
CHANGE_HOME\jetty\webapps\context\WEB-
INF\wsconfig\system\app.user.properties

For WAS:
CHANGE_HOME\context.ear\context.war\WEB-
INF\wsconfig\system\app.user.properties

For WASCE:
CHANGE_HOME\context\WEB-INF\wsconfig\system\app.user.properties

Then add the following lines as necessary:
migrate_ignore_version_delimiter = true
migrate_ignore_release_delimiter = true

Finally, restart Rational Change to apply the changes.
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9 Uninstalling Rational Change
To uninstall Rational Change, run the Uninstall Rational Change program.
Depending on the type of server, you are provided with information about the 
effects of uninstalling the server.
Also, if you are using WAS or WASCE, the:

• User who installed Rational Change has to uninstall the software.

• Servers should be up and running during uninstall.

To remove Rational Change, use Add/Remove Programs on the Control Panel.
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Appendix A: Reference Information
This section provides log file locations and explains how to resolve port conflicts 
or change port assignments, and provides information about installation options, 
including installing with a UNIX Rational Change database.

• “Log files” on page 68

• “Resolving port conflicts for Jetty” on page 70

• “Stopping the Rational Change server for Jetty” on page 71

• “Starting the Rational Change server for Jetty” on page 71

• “Installing on Windows with a UNIX Rational Synergy database” on page 72

• “Installing multiple Rational Change servers for a database” on page 75

• “Configuring Change to use HTTPS” on page 78

• “Updating the RDS configuration file” on page 79
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Log files
Check for status, error messages, and general information in the following log 
files:

• Rational Change

• The Rational Synergy session

• Jetty Web server

• WAS server

• WASCE server

• Installation log files

For information about the variables in the log file paths shown in the table, see 
the “Worksheet” on page 27.

Log file name and location Comments

Jetty:
CHANGE_HOME\jetty\webapps\context\logs\event.log

WAS:
CHANGE_HOME\context.ear\context.war\logs\event.log

WASCE:
CHANGE_HOME\context\logs\event.log

Rational Change application 
log

Jetty:
CHANGE_HOME\jetty\webapps\context\logs\search.log

WAS:
CHANGE_HOME\content.ear\content.war\logs\search.log

WASCE:
CHANGE_HOME\context\logs\search.log

Rational Change search index 
log
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Jetty:
CHANGE_HOME\jetty\webapps\context\logs\audit_log.xml

WAS:
CHANGE_HOME\context.ear\context.war\logs\
audit_log.xml

WASCE:
CHANGE_HOME\context\logs\audit_log.xml

Rational Change admin audit 
log records the following 
admin operations:

• Changes to users

• Package install/uninstall

• Group changes

• ACL changes

• Central/remote server 
registration

ccm_home\log\web_sessions\cm_session_user\ccm_ui.log Rational Synergy session logs. 
cm_session_user is item 12 
on your worksheet.

ccm_home\log\web_sessions\cm_session_user\ccm_eng.log

CHANGE_HOME\jetty\logs\yyyy_mm_dd.jetty.log Jetty Web server log.

Jetty:
CHANGE_HOME\jetty\webapps\install.log

WAS:
CHANGE_HOME\install.log

WASCE:
CHANGE_HOME\install.log

Installation log file created in 
the Rational Change 
installation directory. The log 
file is in the user’s home 
directory within a temporary 
timestamp (13 digit) directory 
if the installation program 
terminates abnormally.

CHANGE_HOME\jetty\logs\stdout.log Rational Change server startup 
log.

Log file name and location Comments
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Resolving port conflicts for Jetty
Jetty port conflicts can occur when Rational Change installations are using the 
same port that are in use by another application. Look in the change.xml file to 
obtain the port number used by Rational Change. Port conflicts can also cause 
related errors, including undefined users and port access failures. These problems 
might not appear immediately.
Resolve any port conflicts by assigning a different port number to one of the 
conflicting port users. Then, restart the Rational Change server.
If the Jetty Web server log reports that there are port conflicts or that subsequent 
use of Rational Change causes errors, check the log files for warnings about port 
conflicts and related errors. For more information, see “Log files” on page 68.
To resolve port conflicts, see “Resolving Rational Change port conflicts on Jetty” 
on page 70.

Resolving Rational Change port conflicts on Jetty
If Rational Change port conflicts on Jetty occur, change the Rational Change 
port number to an unused number by editing the change.xml and web.xml 
files.

1. Log on as the Rational Synergy administrator.

2. Stop the server.

See “Stopping the Rational Change server for Jetty” on page 71.

3. Change the directory to CHANGE_HOME\jetty\etc (CHANGE_HOME is item 1 
on your worksheet).

4. Make a backup copy of the change.xml file.

5. Open the change.xml file.

6. Change the Rational Change port entry.

a. Find the entry for the Rational Change port, for example:
<Call...>

<Arg...>
<Set name="Port">XXXX</Set>
...
</Arg>

</Call>
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b. Change the port setting to an unused port number, for example:
<Call...>

<Arg...>
<Set name="Port">8888</Set>
...
</Arg>

</Call>

Note  The Rational Change server service name remains 
unchanged even if you change the port number.

7. Save and close the change.xml file.

8. Repeat steps 4 - 7 for the web.xml file in the 
CHANGE_HOME\jetty\webapps\context\WEB-INF directory 
(CHANGE_HOME is item 1 on your worksheet).
The entry in the web.xml file is slightly different, for example:

<init-param>
<param-name>port</param-name>
<param-value>8600</param-value>

</init-param>

9. Start the server.

See “Starting the Rational Change server for Jetty” on page 71.

Stopping the Rational Change server for Jetty
In Services, stop the Rational Change server.

Note  The Rational Change server service name is IBM Rational 
Change NNNN, where NNNN is the port number assigned to 
this Rational Change server.

Starting the Rational Change server for Jetty
In Services, start the Rational Change server.

Note  The Rational Change server service name is IBM Rational 
Change NNNN, where NNNN is the port number assigned to 
this Rational Change server.
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Starting and stopping the Rational Change server for WAS and 
WASCE

To start or stop the Rational Change server for WAS and WASCE, you need to 
start or stop the entire application server. Do not merely start and stop the 
Rational Change Web application.

Installing on Windows with a UNIX Rational Synergy database
Rational Change supports multiple databases on the same installation. However, 
if you are running the program with even one UNIX database, all the installation 
databases must be UNIX databases.
The requirements for a Windows server running with a UNIX Rational Synergy 
database are as follows:

• UNIX and Windows Rational Synergy session username (cm_session_user, 
item 12 on your worksheet) and password must be identical.

Rational Change uses the same user password on both Windows and UNIX. 
Therefore, before running Rational Change on a Windows server with a 
UNIX database, ensure that the session user’s password is the same on both 
platforms.

• One UNIX host must run all engine processes.

The number of simultaneous Rational Synergy sessions is limited to the 
number of engine processes that can run on the UNIX engine host.

• Rational Synergy must be installed and operational on the UNIX server.

You must do the following to install on Windows with a UNIX database:

1. “Connecting to a UNIX database” on page 73

2. “Updating Rational Change server settings” on page 74
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Connecting to a UNIX database
During Rational Synergy installation onto a Windows server, make the following 
selections if you will use a UNIX database:

1. In the Setup Type dialog box, select Main server or Additional Server as 
appropriate.

2. In the Rational Synergy Router Information dialog box, specify the 
UNIX router host and UNIX router port number.

3. In the Install Rational Synergy Router dialog box, clear the Install 
Router check box.

4. In the Informix® Database Server Information, clear the Create 
database server check box.

5. In the Connect to UNIX Rational Synergy Server dialog box, select the 
Connect to UNIX Rational Synergy server check box, and then specify 
the path to the UNIX Rational Synergy installation (CCM_HOME).
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Updating Rational Change server settings
Update your Rational Change installation to use a UNIX database by changing 
the server settings.

1. Define the UNIX database (for example, set database to /usr/mnt1/
ccmdb/testdb).

a. Click Administration, and then click the Server tab.

b. Next to Databases, click Add.

c. At the prompt, type the complete path to the database (for example, 
/usr/mnt1/ccmdb/testdb).

d. The Database Configuration subdialog box appears.

e. In Label, type the database label.

f. Specify other database information. (For details, see the Rational Change 
Admin Help.)

2. In the Configuration group, set Optional start arguments to configure 
with UNIX host. Add -h unix_host -u windows_directory (where 
unix_host is the name of the UNIX machine that will run Rational Synergy 
engine processes, and windows_directory is a Windows local path 
specified in item 13 on the worksheet).
-h unix_host -u windows_directory

Note  The –h option controls which host runs Rational Synergy 
engine processes, which must be run on the same host 
type as the database. The Hosts list box controls which 
host runs Rational Synergy client processes, which must 
be run on the same host type as the Rational Change 
server. When configuring a Windows Rational Change 
server with a UNIX Rational Synergy database, the 
Hosts list box must be set to a Windows host and the –h 
option must be set to a UNIX host.

3. Click Save.

4. Ensure that ccm7.1_ess service is running on the Windows server.

5. Ensure that Rational Synergy is configured for a remote client. See the 
Rational Synergy Administration Guide for more information.

6. Restart the Rational Change server on the Windows server.
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Installing multiple Rational Change servers for a database
Rational Change provides no explicit support for server load balancing, but it is 
possible to achieve a similar effect by installing duplicate Rational Change 
installations onto multiple servers. Ideally, each server should access a different 
set of databases, but multiple servers can share access to a common set of 
databases—provided you are willing to manually keep the settings of all the 
installations in sync. Different groups in your organization can then access the 
common databases through different servers, spreading the load among them.

Stand-alone server installation and planning

If you are using a stand-alone server, install Rational Change as usual on each of 
the servers that you want to access the common databases. Each installation 
must:

• Be the same release of Rational Change.

• Use the same authentication mechanism.

• Point to the RDS server.

• Point to the same Rational Synergy release.

Additionally, when a common database is added—either during installation or 
later through the Admin Server tab—its path must match exactly, including 
capitalization, across all installations.
At this time, you should mentally designate a single one of your installations as 
the primary server for the common databases. All other installations will be 
secondary servers. Rational Change does not distinguish primary and secondary 
servers, but changes to the CR process, listbox values, and other settings should 
always be made and controlled on the primary server, and then manually 
propagated to the secondary servers.
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Settings requiring manual synchronization
• CR Process

You should control and edit your CR process XML file only on the main 
server. The process package you generate from this file must be copied from 
the main server to all secondary servers. Your generated process package can 
be found on your primary server, and must be copied to the same directory 
on every secondary server. For each server, install the process package with 
the Package Installer as normal.

For Jetty:
CHANGE_HOME\jetty\webapps\context\WEB-INF\packages

For WAS:
CHANGE_HOME\context.ear\context.war\WEB-INF\packages

For WASCE:
CHANGE_HOME\context\WEB-INF\packages

• Listboxes

You should control and edit your listbox entries only on the main server. 
Listbox values are saved in the applicable directory below. When modified, 
this file must be copied to the same location on every secondary server. For 
each secondary server, load the new listbox values by selecting Load on 
Admin > General.
For Jetty:
CHANGE_HOME\jetty\webapps\context\
WEB-INF\wsconfig\pt_listbox.cfg

For WAS:
CHANGE_HOME\context.ear\context.war\WEB-
INF\wsconfig\pt_listbox.cfg

For WASCE:
CHANGE_HOME\context\WEB-INF\wsconfig\pt_listbox.cfg
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• ACLs

You should control and edit your access control lists (ACLs) only on the 
main server. ACL definitions are saved in several files in the applicable 
directory listed below. When modified, all of these files must be copied to 
the same location on every secondary server. For each secondary server, load 
the new ACL definitions by selecting Admin > General > Load. Next, go 
to Admin > ACL, and enable the same ACLs as on your primary server.

For Jetty:
CHANGE_HOME\jetty\webapps\context\WEB-INF\wsconfig\acl

For WAS:
CHANGE_HOME\context.ear\context.war\WEB-INF\wsconfig\acl

For WASCE:
CHANGE_HOME\context\WEB-INF\wsconfig\acl

• Other Packages

As with your CR process package, any packages installed onto the primary 
server must be copied to and installed on all secondary servers.

• Admin > General Tab

If you modify any settings on Admin > General of the primary server, you 
must apply the same changes on every secondary server.

• Manual pt.cfg Settings

If you manually modify any pt.cfg settings on your primary server, you 
must make the same changes on every secondary server. For each secondary 
server, load the new pt.cfg settings values by selecting Admin > General 
> Load.
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Limitations
Rational Synergy has a number of features that interact with Rational Change. 
These features continue to work, but they know about only one of your Rational 
Change installations: the last installation on which you installed your process 
package. If your users primarily access Rational Change using Rational Synergy, 
then this solution does not provide any benefit. All users are connected to the 
same Rational Change server.
By default, each server maintains its own search index. Since the indices are not 
necessarily updated at the same time, different servers might show different 
results. This only applies to search results. Queries and reports always reflect 
what is currently in your databases.
It is possible to have multiple Rational Change servers configured against the 
same databases to share a search index. This is done by setting the pt.cfg 
configuration entry [CCM_SYSTEM][SEARCH_INDEX_DIRECTORY]full path to 
search directory [/SEARCH_INDEX_DIRECTORY][/CCM_SYSTEM] to have 
the same path on all servers. The default value for the search index is the 
wsconfig/system directory.
Do not point to another server wsconfig\wsconfigsystem\wsconfigindex 
directory as that creates another index. Point to its 
wsconfig\wsconfigsystem directory or point all servers to another directory 
outside of the Rational Change directory hierarchy.

Licensing

Using multiple servers does not affect your licenses. The same number of licenses 
are available whether you use one or more Rational Change installations.

Configuring Change to use HTTPS
For information about configuring Rational Change to use HTTPS, contact IBM 
Rational Software Support to obtain the technical note. The Home page for 
Rational Change products is located at http://www.ibm.com/software/
awdtools/change/support/.
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Updating the RDS configuration file
RDS is normally configured as a post-installation step, and the RDS connection 
information is stored in the rds_config.xml file. The administrator needs to 
edit rds_config.xml file only when the following occurs:

• The RDS URL changes when you want to use a different RDS server or 
when it is moved to another server.

See “Editing the RDS URL” on page 79.

• The RDS admin user name or password was changed.

See “Editing the RDS admin user name and password” on page 80.

The rds_config.xml file is located in the following directory.

For Jetty:
CHANGE_HOME\jetty\webapps\context\WEB-INF\wsconfig

For WAS:
CHANGE_HOME\context.ear\context.war\WEB-INF\wsconfig

For WASCE:
CHANGE_HOME\context\WEB-INF\wsconfig

All changes made to this file are applied when the configuration data is reloaded 
or when the server is restarted.

Editing the RDS URL

To edit the RDS URL:

1. In the rds_config.xml file, edit the <url> line.
<rds-config>
<url>ldap://local host:xxxx/</url>
<user-id>rdsadmin</user-id>
<password>xxxxxxxxxxxx/xxxxxxxxx==</password>
</rds-config>

2. Save the file.
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Editing the RDS admin user name and password
To edit the user name and password:

1. In the rds_config.xml file, edit the <user-id> line.
<rds-config>
<url>ldap://local host:xxxx/</url>
<user-id>rdsadmin</user-id>
<password>xxxxxxxxxxxx/xxxxxxxxx==</password>
</rds-config>

2. Type the new user name.

3. Replace the <password> line with the following:
<password-unencrypted>my_new_password</password-unencrypted>

4. Save the file.

The user name is changed, but the original <password> is replaced by 
<password-unencrypted>, whose content is a clear-text password. When 
the server reloads, the password is encrypted.
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© Copyright 2000, 2009
U.S. Government Users Restricted Rights - Use, duplication, or disclosure 
restricted by GSA ADP Schedule Contract with IBM Corp.
This information was developed for products and services offered in the U.S.A. 
IBM may not offer the products, services, or features discussed in this document 
in other countries. Consult your local IBM representative for information on the 
products and services currently available in your area. Any reference to an IBM 
product, program, or service is not intended to state or imply that only that IBM 
product, program, or service may be used. Any functionally equivalent product, 
program, or service that does not infringe any IBM intellectual property right may 
be used instead. However, it is the user's responsibility to evaluate and verify the 
operation of any non-IBM product, program, or service. 
IBM may have patents or pending patent applications covering subject matter 
described in this document. The furnishing of this document does not grant you 
any license to these patents. You can send written license inquiries to: 

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A. 

For license inquiries regarding double-byte character set (DBCS) information, 
contact the IBM Intellectual Property Department in your country or send 
written inquiries to: 

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan 

The following paragraph does not apply to the United Kingdom or any 
other country where such provisions are inconsistent with local law: 
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES 
THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. 
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Some states do not allow disclaimer of express or implied warranties in certain 
transactions. Therefore, this statement may not apply to you. 
This information could include technical inaccuracies or typographical errors. 
Changes are periodically made to the information herein; these changes will be 
incorporated in new editions of the publication. IBM may make improvements 
and/or changes in the product(s) and/or the program(s) described in this 
publication at any time without notice. 
Any references in this information to non-IBM Web sites are provided for 
convenience only and do not in any manner serve as an endorsement of those 
Web sites. The materials at those Web sites are not part of the materials for this 
IBM product and use of those Web sites is at your own risk. 
IBM may use or distribute any of the information you supply in any way it 
believes appropriate without incurring any obligation to you. 
Licensees of this program who wish to have information about it for the purpose 
of enabling: (i) the exchange of information between independently created 
programs and other programs (including this one) and (ii) the mutual use of the 
information which has been exchanged, should contact: 

Intellectual Property Dept. for Rational Software
IBM Corporation
1 Rogers Street
Cambridge, Massachusetts 02142
U.S.A.

Such information may be available, subject to appropriate terms and conditions, 
including in some cases, payment of a fee. 
The licensed program described in this document and all licensed material 
available for it are provided by IBM under terms of the IBM Customer 
Agreement, IBM International Program License Agreement or any equivalent 
agreement between us. 
Any performance data contained herein was determined in a controlled 
environment. Therefore, the results obtained in other operating environments 
may vary significantly. Some measurements may have been made on 
development-level systems and there is no guarantee that these measurements 
will be the same on generally available systems. Furthermore, some 
measurements may have been estimated through extrapolation. Actual results 
may vary. Users of this document should verify the applicable data for their 
specific environment. 
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Trademarks
Information concerning non-IBM products was obtained from the suppliers of 
those products, their published announcements or other publicly available 
sources. IBM has not tested those products and cannot confirm the accuracy of 
performance, compatibility or any other claims related to non-IBM products. 
Questions on the capabilities of non-IBM products should be addressed to the 
suppliers of those products.
This information contains examples of data and reports used in daily business 
operations. To illustrate them as completely as possible, the examples include the 
names of individuals, companies, brands, and products. All of these names are 
fictitious and any similarity to the names and addresses used by an actual 
business enterprise is entirely coincidental. 
If you are viewing this information softcopy, the photographs and color 
illustrations may not appear. 

Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of 
International Business Machines Corp., registered in many jurisdictions 
worldwide. Other product and service names might be trademarks of IBM or 
other companies. A current list of IBM trademarks is available on the Web at 
Copyright and trademark information at www.ibm.com/legal/
copytrade.htm.
Java, JavaScript, and all Java-based trademarks and logos are trademarks of Sun 
Microsystems, Inc. in the United States, other countries, or both.
Microsoft, Windows, Windows 2003, Windows XP, Windows Vista and/or other 
Microsoft products referenced herein are either trademarks or registered 
trademarks of Microsoft Corporation, in the United States, other countries, or 
both.
UNIX is a registered trademark of The Open Group in the United States and 
other countries.
Other company, product or service names may be trademarks or service marks 
of others.
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